COPYRIGHT LICENSE AGREEMENT

FOR LANGUAGE

This Copyright License Agreement (the “Agreement”) is entered into and effective this ___ day of ____________, 20___ (the “Effective Date”), by and between ____________________________________________ (“Licensor”) and Linguistic Society of America (“LSA”), a District of Columbia non-profit corporation.

WHENAS, Licensor is the sole and exclusive owner and copyright holder of certain written work (the “Work”) as described in Paragraph 4; and

WHENAS, Licensor wishes to publish the Work in Language, the official journal of LSA; and

WHENAS, Licensor agrees to license the Work to LSA for publication in Language.

NOW, THEREFORE, intending to be legally bound, in consideration of the foregoing and of the mutual covenants and agreements contained herein, and subject to the satisfaction of the terms and conditions set forth herein, the parties agree as follows:

1. License. Licensor grants to LSA a non-exclusive, perpetual, irrevocable, unrestricted, royalty-free license to reproduce, publish, republish, distribute, sell, license, transfer, transmit, and publicly display copies of, and otherwise use the Work described in Paragraph 4, in Language. The Work may be used by LSA in whole or in part, alone or in compilations, in all formats and media (including electronic, digital, online, and other media to be conceived or developed), by any method, device, or process, and through any channels, now known or later conceived or developed by LSA for Language, including, but not limited to, publication of the Work via Project MUSE, JSTOR, or LSA’s website. It is understood and agreed that the license granted hereunder expressly allows LSA to sell or license a compilation of materials or a collective work containing the Work copyrighted by Licensor and/or access thereto.

2. Embargo Period. Licensor agrees not to reproduce, publish, republish, distribute, sell, license, transfer, transmit, and publicly display copies of the Work in any other format or media for a period of one (1) year from the date the Work is first published by LSA (the “Embargo Period”). Once the Embargo Period has expired, LSA agrees to publish the Work on its website with open access and agrees that no fee will be charged to access the Work as a stand-alone work. LSA, its affiliates and/or partners shall have the right to charge fees to access any compilation of materials or collective work containing the Work. Once the Embargo Period has expired, Licensor may reproduce, publish, republish, distribute, sell, license, transfer, transmit, and publicly display copies of the Work in any other format or media without restriction.

3. Article Processing Charge. Upon payment of an Article Processing Charge (“APC”) to LSA by Licensor in the amount of $400.00, the Embargo Period set forth in Paragraph 2 will be eliminated. If the APC is agreed to by Licensor, (a) LSA agrees to publish the Work on its website with open access and agrees that no fee will be charged to access the Work as a stand-alone work, and (b) Licensor may reproduce, publish, republish, distribute, sell, license, transfer, transmit, and publicly display copies of the Work in any other format or media without restriction. LSA, its affiliates and/or partners shall have the right to charge fees to access any compilation of materials or collective work containing the Work.

Licensor acknowledges and agrees to the APC. Initial here: __________

4. Work. The Work subject to the granted license is set forth as follows and includes any supplemental material in any format and media (including text, graphic, audio, visual, electronic, or digital) created by Licensor to be reproduced, published, republished, distributed, sold, licensed, transferred, transmitted, displayed, or otherwise used in connection with the Work (provide applicable detail regarding licensed materials):
Title: ________________________________________________________________

Author(s):  ________________________________________________________________

Publisher(s): ________________________________________________________________

Description of Work (including supplemental materials): ________________________________________________________________

Copyright Registration Date: __________________________________________________

5. **Title to Intellectual Property.** Licensor shall retain all right, title and interest in and to the Work, including without limitation, copyrights, trademarks and any other rights and interests. This Agreement does not convey to LSA any right, title or interest in the Work, nor a portion thereof, but only constitutes a license to use the Work as specified herein.

6. **Copyright Acknowledgement.** Full credit and acknowledgement of the original source of the Work and the following copyright statement will be published with the Work as follows:

   Printed with the permission of _______. Copyright 20 __ _______________.

A copy of the copyright registration certificate is attached to this Agreement.

7. **Permissions.** If (a) the Work contains copyrighted material in any format or media (including text, graphic, audio, visual, electronic, or digital) owned by a third-party or (b) supplemental copyrighted material in any format or media (including text, graphic, audio, visual, electronic, or digital) owned by a third-party is to be reproduced, published, republished, distributed, sold, licensed, transferred, transmitted, displayed, or otherwise used in connection with the Work, then Licensor, at Licensor’s sole expense, shall obtain written permission from the copyright owner, in a form and scope acceptable to LSA, for such use of the copyrighted material in the Work or in connection with the publication of the Work. Licensor shall deliver all written permissions for such use of the copyrighted material to LSA together with the Work. Delivery of all required written permissions is a condition of publication of the Work by LSA. Full credit and acknowledgement of the original source of the copyrighted material will be published with the Work or in connection with the Work as follows:

   Printed with the permission of _______. Copyright 20 __ _______________.

The copyrighted material is set forth as follows (provide applicable detail regarding copyrighted material):

   Title: ________________________________________________________________
   Description: ________________________________________________________________
   Copyright Owners(s): __________________________________________________________

8. **Warranties.** Licensor represents and warrants that: (a) Licensor is the sole owner and copyright holder of the Work, Licensor has not assigned, pledged, or otherwise encumbered the Work, Licensor has the right, title, interest and authority to enter into this Agreement; (b) the Work is an original work, which has not been previously published in whole or in part in any format or media, (c) the Work does not infringe or violate any copyright or any other proprietary or personal right of any third-party; (d) the Work contains no material that is libelous, in violation of any right of privacy or publicity, harmful, or illegal so as to subject LSA to liability to any third-party or which is otherwise contrary to law.

9. **Indemnification.** Licensor shall indemnify, defend, and hold harmless LSA and its officers, directors, employees, agents, partners, contractors, licensees, assignees, and transferees from and against any and all loss, damage, expense (including reasonable attorneys’ fees and legal costs), recovery, or judgment arising from any breach or alleged breach of any of the Licensor’s warranties.

10. **Severability.** In the event one or more of the provisions of this Agreement is declared invalid or otherwise unenforceable, the enforceability of the remaining provisions shall be unimpaired.

11. **Modification and Assignment.** This Agreement may not be assigned, modified, waived, revised or amended except by a written instrument signed by both parties.
12. **Relationship of Parties.** Nothing in this Agreement shall be deemed to constitute, create, give effect to or otherwise recognize a partnership, joint venture or formal business entity of any kind; and the rights and obligations of the parties shall be limited to those expressly set forth herein.

13. **Governing Law.** This Agreement shall be governed by and construed exclusively in accordance with the laws of the District of Columbia and the United States of America and any claim or cause of action arising under this Agreement shall be adjudicated exclusively in the courts located in the District of Columbia.

14. **Waiver.** No requirement of the Agreement shall be deemed waived or varied, nor shall either party’s failure or delay to assert any default of the other party constitute a waiver of a party’s rights hereunder, or a waiver of a party’s right to assert any subsequent or continued breach by the other party of any covenant, term or condition contained in this Agreement.

15. **Complete Agreement.** This Agreement supersedes all prior agreements and constitutes the entire understanding between the parties hereto and no modification or amendment thereof will bind either party unless it shall be in writing and signed by persons authorized to bind both parties to the Agreement.

IN WITNESS WHEREOF, each party has caused this Agreement to be executed on its behalf by a duly authorized officer as of the Effective Date.

Linguistic Society of America

By: ________________________________
Name: Greg Carlson
Title: Editor
Date: ________________________________

Licensor

By: ________________________________
Name: ________________________________
Title: ________________________________
Date: ________________________________
1. Introduction

eProof files are self-contained PDF documents for viewing on-screen and for printing. They contain all appropriate formatting and fonts to ensure correct rendering on-screen and when printing hardcopy. DJS sends eProofs that can be viewed, annotated, and printed using the free version of Acrobat Reader 7 (or greater). These eProofs are “enabled” with commenting rights, therefore they can be modified by using special markup tools in Acrobat Reader that are not normally available unless using the Standard or Professional version.

The screen images in this document were captured on a PC running Adobe Acrobat Reader version 8.1.0. Though some of the images may differ in appearance from your platform/version, basic functionality remains similar. At the time of this writing, Acrobat Reader v8.1.0 is freely available and can be downloaded from: http://www.adobe.com/products/acrobat/readstep2.html

2. Comment & Markup toolbar functionality

A. Show the Comment & Markup toolbar

The Comment & Markup toolbar doesn’t appear by default. Do one of the following:

• Select View > Toolbars > Comment & Markup.
• Select Tools > Comment & Markup > Show Comment & Markup Toolbar.
• Click the Review & Comment button in the Task toolbar, and choose Show Comment & Markup Toolbar.

To add or remove tools for this toolbar, right-click the toolbar and select the tool. Or, select Tools > Customize Toolbars.

B. Select a commenting or markup tool

Do one of the following:

• Select a tool from the Comment & Markup toolbar.
• Select Tools > Comment & Markup > [tool].

Note: After an initial comment is made, the tool changes back to the Select tool so that the comment can be moved, resized, or edited. (The Pencil, Highlight Text, and Line tools stay selected.)

C. Keep a commenting tool selected

Multiple comments can be added without reselecting the tool. Select the tool to use (but don’t use it yet).

• Select View > Toolbars > Properties Bar.
• Select Keep Tool Selected.

Choose Tools > Customize Toolbars to remove unnecessary items from the toolbar (see Section 7 for suggested toolbar layout)
3. The Properties bar
The Properties bar can be used to format text and select options for individual tools.

To view the Properties bar, do one of the following:
- Choose View > Toolbars > Properties Bar.
- Right-click the toolbar area; choose Properties Bar.
- Select [Ctrl-E]

4. Using the comment and markup tools
To insert, delete, or replace text, use the Text Edits tool. Select the Text Edits tool, then select the text with the cursor (or simply position it) and begin typing. A pop-up note will appear based upon the modification (e.g., inserted text, replacement text, etc.). Use the Properties bar to format text in pop-up notes. A pop-up note can be minimized by selecting the button inside it.
5. Inserting symbols or special characters
An 'insert symbol' feature is not available for annotations, and copying/pasting symbols or non-keyboard characters from Microsoft Word does not always work. Use angle brackets < > to indicate these special characters (e.g., <alpha>, <beta>).

6. Editing near watermarks and hyperlinked text
eProof documents often contain watermarks and/or hyperlinked text. Selecting characters near these items can be difficult using the mouse alone. To edit an eProof which contains text in these areas, do the following:

- Without selecting the watermark or hyperlink, place the cursor near the area for editing.
- Use the arrow keys to move the cursor beside the text to be edited.
- Hold down the shift key while simultaneously using arrow keys to select the block of text, if necessary.
- Insert, replace, or delete text, as needed.

7. Summary of main functions
Insert text - Use Text Edits tool (position cursor and begin typing)
Replace text - Use Text Edits tool (select text and begin typing)
Delete text - Use Text Edits tool (select text and press delete key)
Highlight text - Use Highlight Text tool (select text)
Attach a file - Use the Attach a File with Comment tool (select tool, position cursor and click mouse, select file)

8. Reviewing changes
To review all changes, do the following:

- Select the Show button on the Comment & Markup toolbar.
- Select Show Comments List.

Note: Selecting a correction in the list will highlight the corresponding item in the document, and vice versa.

9. The eReturn process
A. An email is received that contains a link to the eProof of the article:
B. Click on the link to open the proof with the internet browser. Select “Save As” from the browser’s ‘File’ menu to save a copy of the PDF to the desktop or other folder.
C. Close the browser and open the saved PDF file with Acrobat.
D. Make corrections using Acrobat’s Comment & Markup tools.
E. Save the PDF file, now with annotations, and return according to the instructions provided by the DJS journal manager.
ON THE LINGUISTIC EFFECTS OF ARTICULATORY EASE, WITH A FOCUS ON SIGN LANGUAGES

Donna Jo Napoli Nathan Sanders Rebecca Wright
Swarthmore College Swarthmore College Swarthmore College

Spoken language has a well-known drive for ease of articulation, which Kirchner (1998, 2004) analyzes as reduction of the total magnitude of all biomechanical forces involved. We extend Kirchner’s insights from vocal articulation to manual articulation, with a focus on joint usage, and we discuss ways that articulatory ease might be realized in sign languages. In particular, moving more joints and/or joints more proximal to the torso results in greater mass being moved, and thus more articulatory force being expended, than moving fewer joints or moving more distal joints. We predict that in casual conversation, where articulatory ease is prized, moving fewer joints should be favored over moving more, and moving distal joints should be favored over moving proximal joints. We report on the results of our study of the casual signing of fluent signers of American Sign Language, which confirm our predictions: in comparison to citation forms of signs, the casual variants produced by the signers in our experiment exhibit an overall decrease in average joint usage, as well as a general preference for more distal articulation than is used in citation form. We conclude that all language, regardless of modality, is shaped by a fundamental drive for ease of articulation. Our work advances a cross-modality approach for considering ease of articulation, develops a potentially important vocabulary for describing variations in signs, and demonstrates that American Sign Language exhibits variation that can be accounted for in terms of ease of articulation. We further suggest that the linguistic drive for ease of articulation is part of a broader tendency for the human body to reduce biomechanical effort in all physical activities.*

Keywords: sign languages, phonetics, articulatory ease, movement, joints


We first discuss what we mean by ease of articulation (§2), so that the notion can be appropriately understood here. We then give an overview of some of the known evidence that ease of articulation plays a role in spoken languages and what effects ease of articulation could have in sign languages. In §3, we describe a study we undertook of the signing of two native, adult users of American Sign Language (ASL), with a focus on joint usage in casual signing. We report on the findings of this study in §4.

We conclude that all language, regardless of modality, is shaped by a general functional pressure toward articulatory ease that likely goes beyond language proper.

2. Ease of articulation in language. Both spoken languages and sign languages demonstrate a drive toward ease of articulation. We begin by defining what we mean by ease of articulation, outlining a formal approach that turns out to be impracticable in the

* We thank Jami Fisher, Gaurav Mathur, and Gene Mirus for discussion of both data and earlier drafts. We thank Adam Albright, Greg Carlson, Adrienne Cheek, Onno Crasborn, Karen Emmorey, and three anonymous referees for comments on earlier drafts. Versions of this work were presented at SUNY Stony Brook in May 2011 and at Columbia University in January 2013, and we thank members of the audiences for their feedback. We thank Carol Padden and Aileen Panzer for discussion of data. We thank Adam Petrie and Lynne Schofield for help with the statistics. We thank Rosanna Kim for discussion of data and for being our photograph model. We thank Dorothy Kunzig for taking the photographs.
general case, but which we reduce to a more straightforward diagnostic that is intuitively appealing. We then move on to defining and exemplifying ease of articulation in spoken languages and sign languages.

2.1. Ease of articulation as effort reduction. To make a comparison of ease of articulation across pronunciations, we need an explicit notion of the concept of ease that can be applied to articulatory gestures in language. We define articulatory ease as reduction of effort, following Kirchner (1998, 2004), whose fundamental ideas about speech can be applied to signing.

Effort is a neuromuscular notion: a nerve impulse activates a group of muscle fibers to twitch, which consumes adenosine triphosphate (ATP). Repeated firing is needed for full contraction of the muscle group. ‘Effort, then, is the extent of this activation: specifically, the total sum (integral) of the action potentials of a motor group, summed over each active motor group, for every muscle in the vocal tract: or, in neurochemical terms, the amount of ATP consumed by the muscles of the vocal tract’ (Kirchner 1998:37).

To compare effort, we could use electromyography (EMG) techniques to measure effort of an individual muscle. But both the vocal tract and the manual articulators involve many muscles, so we would have to measure activation information for all of the muscle groups involved in the articulatory gesture; but, as Kirchner (1998:39) notes, ‘there are at present no techniques of measuring such global activity directly’. Instead, one might adopt a biomechanical approach, defining effort as work or energy. The problem is that there is no work if there is no motion, but we can certainly expend effort without movement, as in pushing ineffectively against a brick wall, or isometrically tightening the biceps and triceps at the same time. So Kirchner opts for force as a ‘better mechanical analog of effort’ (1998:39). Using Nelson 1980, he says the force involved for a given articulatory displacement is represented by Newton’s second law of motion.

\[ \mathbf{F}(t) = m \frac{dv}{dt} \]

Here, \( m \) is the mass, and \( dv/dt \) is the instantaneous acceleration of that mass at time \( t \).

In this approach, no actual displacement is required in order for force to be exerted, so in the case of isometric tension, where there is an antagonistic force equal to the agonistic force, the lack of displacement does not entail a lack of force.

For language gestures, the effort in an entire articulatory gesture is a sum of the forces associated with each component gesture. Kirchner calculates this by integrating \( F(t) \) over the duration of an articulation, from time \( t_i \) to time \( t_j \).

\[ \text{total effort} = \int_{t_i}^{t_j} |\mathbf{F}(t)| \, dt \]

We also need to take into account differences in the effort of moving different articulators. Kirchner gives a computational model of a mass-spring system to calculate the forces involved in moving different articulators (1998:43–50). Calculating exact amounts of force for a given manual gesture over arbitrary individuals is infeasible, however, and beyond the scope of our research: (i) different muscles in the arms and hands are made of fibers of different lengths, and moving muscles in different ways takes different amounts of effort (Holzbaur et al. 2005); (ii) arm strength levels vary between individuals; and (iii) control of the spatial location of the hands becomes more of a chore with aging (Ribeiro & Oliveira 2007).

Henceforth, we work with only two generalizations: (i) moving a greater mass requires greater effort; and (ii) moving a given mass at an increased speed requires greater effort (cf. Perkell et al. 2002). These need to be curtailed when matters of precision
come in, since it may take more effort to make a small motion such as threading a needle, even slowly, than a large one. Kirchner assumes 'that an increase in precision translates to an increase in total neuromuscular activation, and to an increase in the total force involved in the utterance' (1998:52). So precision is a kind of biomechanical force, making it possible to discuss trade-offs between precision and other expenditures of effort. Again, however, we do not attempt to evaluate these trade-offs with exact calculations of effort.

Nevertheless, these generalizations need to be enriched when it comes to movement involving multiple articulators. Coordination of movement of two articulators in space and time adds computational costs (for speech see Willerman 1994 and Willerman & Lindblom 1991). Thus, moving two manual articulators takes double the biomechanical effort of moving a single one (given that articulators typically move symmetrically; see Napoli & Wu 2003, Mai 2008:87) and adds computational cost.

Coordination of multi-joint movements is likewise computationally more difficult than performing a single-joint movement. For example, holding the arm with the elbow flexed at a right angle and the fingers extended parallel to the ground, and then reaching forward (as if reaching for a cup), calls for movement of elbow and shoulder joints, whereas starting from the same position, but moving the arm so the fingers point across the body (as if reaching to scratch the other arm) calls only for rotation of the shoulder joint. The first requires more complex coordination than the second (Haggard et al. 1995). So when we consider variants of signs in which joints are frozen, computational costs in producing those signs will be reduced.

Further, physiological connections sometimes impinge on effort. Mandel (1979:225) demonstrates that certain combinations of base knuckle (the metacarpophalangeal joints) and wrist movement are more efficient than others; movement of both of these joints together can therefore be favored over movement of either alone (sometimes leading to historical change that obfuscates the original iconicity of a sign). In our study, we did not come across such examples; we mention this only to show how physiology can complicate the notion of effort.

Here, then, we take ease of articulation to be primarily defined by reduction of biomechanical effort. Ease of articulation also involves reducing factors such as computational costs, which might well be a type of force, just as Kirchner assumes precision is. If so, perhaps all ways of achieving articulatory ease are equivalent to reduction of biomechanical effort. We leave this question open, and frame the rest of our discussion of articulatory ease in terms of effort reduction based on the masses of the articulators and their respective accelerations.

2.2. Ease of articulation in spoken language. Difficult or complex articulations in speech are often reduced, simplified, or avoided, but only so far as communication is still possible; we have intended recipients and a desire for them to understand our message. This requires the speaker to pay some level of attention to the effort the listener must put into interpreting what is said. In general, these two factors (reduction of the speaker’s articulatory effort and reduction of the listener’s perceptual effort) are in direct competition in spoken language: speech sounds that are easier to produce are typically less perceptually distinctive, while more perceptually salient speech sounds typically require increased articulatory effort to produce (Lindblom 1990). Diachronically, the result is multiple tugs-of-war in any given language between speaker- and listener-oriented effort reduction (cf. Vennemann 1993). Thus, though our focus is on reduction of articulatory effort, perceptual considerations are also always a background consideration, preventing the linguistic signal from degrading completely into uninterpretable mumbling.
An example of how a drive for articulatory ease can shape sound patterns is the crosslinguistic preference for high vowels, rather than lower vowels, to be targets of devoicing. For example, in Japanese, high vowels are voiceless between voiceless consonants (as in *kiَاˈ north’) and voiced elsewhere (as in *kigeˈ ‘mood’ and *ikaˈ ‘squid’), while mid and low vowels are always voiced, even when they occur between voiceless consonants (as in *toَاˈ land’) (Han 1961, Beckman 1982, Beckman & Shoji 1984, Tsuchida 1994, 1997, Tsujimura 2007).

This pattern follows from two primary articulatory facts. First, the higher tongue position for high vowels creates a greater obstruction in the oral cavity, which impedes the airflow necessary for voicing (Jaeger 1978). As air flows across the glottis into the oral cavity (indicated by the arrows in Figures 1 and 2), supraglottal air pressure (indicated by dot density in Figs. 1 and 2, with greater density corresponding to higher air pressure) builds up more quickly for the high vowel articulation (Fig. 1) than for a lower vowel articulation (Fig. 2). Consequently, more pulmonic effort is needed for the airflow across the glottis to overcome the resistive force of the oral cavity’s higher air pressure. Devoicing high vowels thus reduces pulmonic effort.

High vowels are also preferred targets for devoicing because they are naturally shorter than low vowels (Lehiste 1970), and shorter vowels are more prone to devoicing than long vowels (Gordon 1998). This is especially true when the vowel is between voiceless consonants (Dauer 1980, Jun & Beckman 1993, 1994, Jun et al. 1997, Jun et al. 1998), where the vocal folds are spread apart for the voicelessness of the first consonant, then adduct to a suitable position for vowel voicing, and then spread again for the second consonant. Because high vowels have a shorter duration than low vowels, this leaves less time for the vocal folds to move into position for voicing, so they must move more quickly, requiring greater acceleration. Greater acceleration requires greater force and, thus, greater articulatory effort. To avoid this extra effort, the vocal folds can remain in the same position from one voiceless consonant to the next, throughout the vowel, making it voiceless as well. With a lower (longer) vowel, however, there is more time to get the vocal folds into position for voicing, reducing acceleration, which requires less force and therefore less articulatory effort.

The significance of articulatory effort in speech is also seen in plosive voicing (Ohala 1983, Westbury & Keating 1986). A voiced plosive requires two articulations: a full stop closure in the oral cavity, and significant continuous pulmonic airflow across the vocal folds. As air fills the space behind the stop closure, the airflow from voicing...
causes an increase in oral air pressure. Plosives made farther back in the mouth have smaller spaces behind them (Figure 3).

Since pressure is inversely proportional to volume, the pressure will be greater (and rise faster) in a smaller space than in a larger one. With greater air pressure, more pulmonic effort is required to maintain sufficient airflow for voicing, and more effort is expended by the main articulator to hold a full stop closure against the increasing air pressure behind it. Thus, it requires more overall effort to produce a voiced plosive farther back in the mouth, like [ɡ], than one nearer the front, like [d] or [b].

This difference in articulatory effort based on backness of the stop closure in plosives is reflected in crosslinguistic phonemic inventories: many languages, such as Classical Arabic (Watson 2002), Cubeo (Morse & Maxwell 1999), Dutch (Gussenhoven 1999), Efik (Welmers 1973), Hixkaryana (Derbyshire 1985), Makah (Jacobsen 1979), Sui (Li 1948), and Thai (Iwasaki & Ingkaphirom 2005), have a gapped system of plosives missing /ɡ/, as in 3a, but fewer languages have gapped systems like those in 3b or 3c, which are missing /b/ and /d/, respectively.

(3) a. p t k  b. p t k  c. p t k
     b d  d g  b g

In the UCLA Phonological Segment Inventory Database (UPSID; Maddieson 1984, Maddieson & Precoda 1989), there are at least forty-eight languages with plosive inventories like 3a, but only eight like 3b and/or 3c (Brao, Eyak, Kewa, Mazahua, Mixe, Pirahã, Rotokas, and Tigak), and UPSID may be incorrect about Rotokas, which, according to Robinson (2006), has the full ungapped series of voiced plosives.

The increased articulatory difficulty of voicing in back plosives is also manifested as synchronous allophony for underlyingly voiced plosives: back voiced plosives may devoice or spirantize in some environments, while voiced plosives made farther forward remain unchanged in the same environments. For example, word-final /ɡ/ devoices in Tonkawa (Hojier 1933), and intervocalic /ɡ/ spirantizes in Jamsay (Heath 2008), but /b/ and /d/ remain voiced stops in both languages.

Our final example of how spoken language can be shaped by concerns about articulatory ease comes from Kirchner (1998), who argues that the lenition of stops to continuants is governed by a drive to decrease effort by reducing the magnitude of the constriction gesture. Because a stop involves a closure against the passive articulator, it requires moving the active articulator a greater distance than a continuant does. Consequently, since force increases as a mass is moved a greater distance, a stop should require more effort to produce than a continuant does (Figure 4).
Thus, we might expect /t/ to spirantize in a lenition environment potentially in different ways: it might become [s] in some languages and [θ] in others. However, Kirchner notes that strident fricatives like [s] involve extra effort; they need high-pressure airflow focused through a precisely controlled narrow channel in order to attain their characteristically high-intensity noisy sound. Maintaining this control requires isometric tension, achieved by adding a downward antagonist force to the force of the constriction gesture. Kirchner argues that the total effort involved for a strident fricative (the magnitude of its constriction gesture plus the magnitude of the antagonist force needed to create isometric tension) is greater than the total effort for the corresponding stop, which has only a constriction gesture (Figures 5a–b).

Furthermore, a strident fricative requires more total effort than a nonstrident continuant (fricative or sonorant), as shown in Figures 5b–c. Unlike strident fricatives, the articulation of nonstrident continuants can vary somewhat without significant sound distortion, so they do not need to be held by isometric tension at a precise distance from the passive articulator, which means that they do not require the same antagonist articulatory force that strident fricatives need. In addition, the wider opening of nonstrident continuants (as compared to stops or strident fricatives) involves a lower magnitude constriction gesture and therefore less total effort. There is thus a cline in effort: strident fricatives > stops > nonstrident continuants. So if lenition is governed by effort reduction (as Kirchner argues), stops should lenite only to nonstrident continuants, never to strident fricatives. Kirchner’s crosslinguistic survey of lenition confirms this prediction: when stops do spirantize due to lenition, they become nonstrident continuants in-
stead of strident fricatives (1998:99), indicating that lenition is governed by a drive to reduce articulatory effort.

2.3. EASE OF ARTICULATION IN SIGN LANGUAGES. Sign languages also exhibit a number of ways in which they reduce articulatory effort. In order to talk meaningfully about articulatory effort in sign languages, we need to understand the relevant articulators and what kind of effort is involved in moving them. There are two classes of articulators used in sign languages: the manuals and nonmanuals. The manual articulators (the various parts of the hands and arms) are the focus of this research and are described below. But first, we briefly turn to the nonmanuals.

NONMANUAL ARTICULATORS. The nonmanual articulators include facial parts (eyebrows, eyes, nose, cheeks, lips, tongue), the whole head itself, and the torso. All of these articulators can move in a variety of ways, many of which can be exploited in sign languages. Most nonmanual articulations accompany manual articulations in one of several roles: they can be part of the lexical item (and thus obligatory); they can carry morphological/semantic or syntactic (functional) information (such as the intensity of a predicate or whether an utterance is a question); they can be affective, showing an emotion appropriate to the overall message (thus an ASL signer might smile during HAPPY in HAPPY YOU? but not in NOT HAPPY YOU?); and they can be used to repair or monitor an utterance (Baker & Padden 1978, Dively 1998). Some signs may even have both a manual and a separate, completely nonmanual counterpart (indicated here by prefixing ‘NHS:’ for ‘non-hand-sign’). For example, the ASL sign NHS:YES consists of two gentle head nods; the ASL sign NHS:PUZZLED consists of a slight backward movement of the torso, lowering of the chin, and squinting of the eyebrows (Dively 2001); and in casual conversation, some signers can eliminate the manual articulator of the ASL sign NOT-YET, so that the sign is completely nonmanually articulated, with the mouth slightly open and the tongue tip covering the bottom teeth (Adrienne Cheek, p.c., March 2011).

While consideration of the nonmanuals might enrich a discussion of effort, it is not trivial to incorporate such consideration here. The effort expended in activating and moving facial nonmanuals would be hard to compare across the articulators, since differences in their mass are not as immediately obvious as they are for the manuals (the fingers are clearly much less massive than the forearm). In addition, the types of movements in the nonmanuals vary greatly, so even with knowledge of their masses, it would be hard to compare the relative articulatory effort of, for example, eyebrow raising and nose wrinkling. Furthermore, and most relevant to this research, there are very few nonmanual joints (most notably, the temporomandibular joint, which allows the jaw to open and close), and they do not generally have the same kind of linearly organized spatial relationship that the manual joints do. Thus, while manual articulations often vary through the use of different joints (the elbow instead of the shoulder, the wrist instead of the elbow), it is not obvious how such variation would be reflected in the joints of nonmanual articulation, if at all.

The only nonmanual articulator that might lend itself to our discussion is the torso, since it has multiple points along its length at which flexion or rotation can occur, and the various parts above and below each of those points have obviously different relative masses. Torso movements typically indicate nonsegmental information: intonational units (Nespor & Sandler 1999, Sandler 1999), discourse units (Boyes-Braem 1999), questions (Neidle et al. 1997), or tenses (Aarons et al. 1992). This means that the torso primarily delivers information that is unlikely to undergo articulatory change for effort-
reduction reasons. As Kirchner (1998:108) says about Irish consonant mutation, which superficially resembles lenition, ‘[h]aving become morphology-driven rather than effort-driven in the synchronic grammar, this process is no longer bound by considerations of effort minimization in the choice of output’.

Given these problems with applying our definition of articulatory effort to the nonmanuals, the rest of this work considers effort only with respect to manual articulations. Nonmanual articulators warrant future research, however, and effort-based results can certainly be found. For example, a recent study shows that as the speed of signing increases, there is a decrease in the duration of brow raises and lowerings and in the duration and number of eyeblinks (Wilbur 2009). This information is consistent with our notion of effort, specifically that greater acceleration requires more effort, so as conversation rate increases, signers avail themselves of ways to reduce the effort expended in making signs. The same happens in speech: informal conversation tends to be faster and more effort-efficient (Kirchner 1998, 2004), with a result that is more fluid and smooth (in the sense of Freed 1995) than isolated citations of formal conversation (Lindblom 1990).

**Manual articulators.** The manual articulators are the joints in the arm, from the shoulder down to the knuckles in the hand. There are four joints in the arm: the shoulder, the elbow, the radioulnar, and the wrist. There are three sets of knuckles in each finger, and two sets of knuckles in the thumb. The base joints (the first set of knuckles, which connect the digits to the hand), are also known as the proximal phalangeal joints or the metacarpophalangeal joints. The interphalangeal joints (the second set of knuckles) are also known as the medial phalangeal joints. Ordinary people are not trained to move the third set of knuckles, the distal phalangeal joints, separately from the interphalangeal joints (cf. violinists; see Katt & Leddy 2005), so their movement in signs is unsurprisingly never independent of the interphalangeal joints. Thus, we ignore the distal phalangeal joints in this work. These six joints are identified in Figure 6, which shows how they are laid out from most proximal (closest to the body) to most distal (farthest from the body) (as in Meier et al. 2008:80).

![Figure 6. Six manual joints.](image)

Movement of the shoulder joint entails movement of the entire arm. That movement might be simply rotation of the arm as it hangs and twists at one’s side, with no path (that
is, no displacement). But it could be many other movements with varying paths (that is, movement through space), such as the enormous arc formed by arm abduction (which is true abduction, taking the humerus from parallel to the spine to perpendicular out to the side, followed by upward rotation of the scapula, raising the humerus above the shoulder until it points straight upward). The largest manual paths possible are produced by shoulder movement, the next by elbow movement, the next by wrist movement, and so on, down the arm, from most proximal joint to most distal joint (although note that radioulnar movement does not produce a path; see discussion below). Since movement of the most proximal joint, the shoulder, results in the entire upper limb moving, shoulder movement moves the greatest mass possible for a sign joint, which means that, in a strict comparison of one joint to another, movement of the shoulder will take the greatest amount of effort. Likewise, as we move down the arm from the shoulder, movement of a more distal joint will move less mass than movement of a more proximal joint. So, for movements that involve only one joint, movement of the more proximal joint will take more effort. That is, the scale in Fig. 6 is not just a scale of proximity; it also reflects the relative amount of articulatory effort it takes to move that joint, from greatest effort on the left to least effort on the right.

Additionally, how a joint moves is relevant for a discussion of effort. We can contrast two different movements of the same joint that both move the same mass, as in the previous example of the shoulder joint moving in a huge arc (arm abduction) and with no displacement (simple rotation). But we can also contrast movements of different joints that move the same mass in different ways. For example, if we let the arm drop at our side, and then flex the elbow to lift the forearm and hand, while keeping the upper arm in place, as in Figure 7a, we have expended a certain amount of effort. If instead we rotate the forearm, while keeping the entire arm and hand pointing in the same direction, so that the radius and ulna (the two large bones of the forearm) twist around each other, as in Figure 7b, we have expended a different amount of effort.

In both types of movement in Fig. 7, we are moving the same mass: the part of the arm from the elbow down. But when we flex the elbow, the movement has a path, whereas when we rotate the forearm by radioulnar articulation, the movement does not have a path. The movement of the elbow joint acts against the resistive force of gravity, since the height of the forearm and hand changes; that is, elbow flexion has lift, while ra-
dioulnar movement does not. The muscles of the arm must put in more force to produce the torque necessary for lifting the forearm than what is needed for twisting it. So moving the radioulnar joint requires less effort than moving the elbow. Therefore, the position of the radioulnar joint in Fig. 6 reflects not only proximity to the torso, but also the articulatory effort involved in movement of that joint, just as the positions of all the other joints in Fig. 6 do, even though radioulnar movement does not create a path.

Since the mass of the body moved by each of the joints increases for more proximal joints, to make a given target path (a straight line, an angle, an arc) by moving a particular joint or combination of joints, the force exerted by the articulators will also be greater for more proximal articulations. This means more effort is required to move more proximal articulators, and less effort is required to move more distal articulators. If the only drive at work in casual, quick conversation were the drive for ease of articulation, we might expect no movement at all. But, as with spoken language, that would result in unintelligibility, which runs counter to the communicative purpose of language. Maintaining a minimum requirement of intelligibility, we might expect to find only interphalangeal movement. Indeed, for recognizing a sign, ‘the more distal the joint, the more information its movement carries for sign identification’ (Poizner et al. 1981:440). Nevertheless, the smaller an object in motion (or static) is, the more visual acuity is required to perceive it (where other factors may interfere, including angular velocity; see Ludvig & Miller 1958). Thus, the addressee’s visual acuity favors movement of more proximal joints, resulting in higher perceptual salience (Brentari 1998: 133ff., Poizner et al. 2000:447), counter to the drive for ease of articulation, and exactly parallel to the competition between articulatory ease and perceptual salience in spoken language.

A confounding factor with a simple effort-based notion of articulatory ease for the manual joints is accuracy. For the purpose of positioning hands in three-dimensional space, the shoulder can be moved with greater accuracy than the other manual joints (Karduna & Sainburg 2012), probably because of the high versatility of shoulder joint movement (see Inman & Abbott 1944): movement of the shoulder can involve flexion (moving the arm forward, parallel to the midsagittal plane), extension (moving the arm backward, parallel to the midsagittal plane), abduction (moving the arm upward, perpendicular to the midsagittal plane), adduction (moving the arm downward, perpendicular to the midsagittal plane), transverse abduction and adduction (moving the outstretched arm horizontally toward and away from the midsagittal plane in front of the body), internal and external rotation (rotating the bent arm horizontally toward and away from the midsagittal plane in front of the body), and so forth. Thus, if a signer gives up movement of the shoulder in order to reduce effort, the result might be a sacrifice of accuracy of path shape.

So, the visual-perceptual needs to maintain path shape will often oppose the drive for articulatory ease with respect to shoulder joint movement. Nevertheless, many signers do distalize movement from the shoulder joint to varying amounts, which is testament to the strength of the drive for ease of articulation in sign languages. And, in fact, we should expect the drive to be exceptionally strong for at least two reasons. First, the various articulators differ so greatly in mass that the differences in effort expended in mov-
ing them is much greater than the differences in effort expended in moving the various articulators in spoken language. Second, at the lexical and sublexical levels, sign language units take longer to articulate than spoken language units. For adults it generally takes around twice as long to articulate a sign as it takes to articulate a spoken word (Bellugi & Fischer 1972). In canonical infant babbling (characterized by a temporal organization of articulation types, resulting in what appear to be ‘syllables’), it takes around 1000 ms to articulate a sign syllable (Petitto et al. 2004), but only around 300 ms to articulate a spoken syllable (Dolata et al. 2008). So the need to reduce effort, particularly on isolated signs, is further exaggerated in sign languages.

**Types of evidence for ease of articulation in sign languages.** There are multiple ways a sign language may exhibit a drive toward ease of articulation. For example, in two-handed signs in which the hands move independently with reflexive symmetry across the midsagittal plane, the nondominant hand can be omitted by weak drop (Padden & Perlmutter 1987). Signers use a two-handed version of a sign in formal registers, but they may use a one-handed version in casual registers (Zimmer 2000), thus expending half of the biomechanical effort (and no computational costs of coordination). Additionally, even formal versions of originally two-handed signs may undergo weak drop over time (Frishberg 1975). While citation forms, such as those found in online dictionaries like Signing Savvy (SS) and ASL Pro (AP), generally reflect formal pronunciations (Baker-Shenk & Cokely 1980:96), SS presents an even more formal pronunciation than AP does, articulating UGLY with two hands, while AP employs weak drop.

Another reduction in movement is weak freeze (Padden & Perlmutter 1987): a two-handed reflexively symmetrical sign has a variant in which the hands assume the ordinary location for the sign, but the nondominant hand does not otherwise move. In the SS version of INTERPRET, for example, both hands move, while AP employs weak freeze. Movement can also be reduced by decreasing the number of repeated movements in a sign. For example, GIRL has two movement segments in SS, but only one in AP (and see Mak & Tang 2011 for Hong Kong Sign Language).

Another pertinent issue is variation in types of symmetry. Some two-handed signs use translational symmetry (the hands move with a constant distance between them without regard to a fixed plane). One might want to examine the frequency at which signers produce variants with reflexive symmetry instead, which requires the least coordination effort for moving hands independently, since each hand does the ‘same’ task with respect to constraints on movement (spacing, timing, and so on). Swinnen and Wenderoth (2004:19) explain it thus: ‘The basic rule of thumb is that the more the constraints act in coalition, the more stable and accurate the coordination pattern will be’. For example, the more conservative SS uses translational symmetry for READY (both R-handshapes move ipsilaterally), whereas AP uses reflexive symmetry (both R-handshapes move away from the midsagittal plane). Interestingly, SS gives three more variants for READY, two of which use reflexive symmetry, and one of which is a fingerspelling. Again, translational symmetry tends to change to reflexive symmetry in diachronic change (Frishberg 1975).

Instances in which articulations are cut short also demonstrate effort reduction. Mauk (2003) shows that undershooting of vowels in spoken language finds an analogy in sign languages in handshapes and locations. With respect to undershooting handshapes, lack of precision reduces effort (and see Ortega & Morgan 2010 for relevant discussion of British Sign Language). Alternatively, one could avoid the precision effort of difficult handshapes by using them less frequently. Indeed, articulatory difficulty of a handshape correlates with its frequency (Ann 2005, 2006 for Taiwanese Sign Language, and Ecca-
rius 2008, 2011 for ASL, Swiss-German Sign Language, and Hong Kong Sign Language). With respect to undershooting location, in fast signing, signers ‘have two options: undershoot a phonetic location target or increase articulatory effort so that they can achieve the location targets more quickly’ (Mauk 2003:329). Signs made at the periphery and even outside the normal signing space from waist to forehead (Emmorey 2001) present the greatest location effort challenge (e.g. in ASL, ROOSTER is articulated on top of the head, and NAVY at hips). Again, an alternative is to reduce frequency, though we know of no studies. Note that we’d expect less avoidance among signers who use larger signing spaces, such as black signers (Hill et al. 2009) and native-singer parents while signing to their deaf infants (Holzrichter & Meier 2000).

Following up on work by Brentari and Poizner (1994), Poizner and colleagues (2000) note that signers with Parkinson’s disease undershoot (what they call ‘laxing’ or ‘neutralizing’) on both handshape and location. Further, they reduce the number of movements in a sign and distalize movement. They conclude that the disease taxes motor planning and articulation systems to the point where there is ‘no room for excess effort or redundant distinction’ (Poizner et al. 2000:449). That is, they consider all of these phenomena to be ways to reduce articulatory effort.

In our study, reported on in §§3–4, we have chosen to investigate the range of ways that effort can be reduced based on the selection of joints used in usual variants of a sign. Before presenting our quantified data, we offer selected examples that demonstrate the phenomena at hand.

**Selection of joints involved.** Joint involvement is a rich area to investigate with respect to establishing a drive toward ease of articulation in sign languages. One variant of a sign can differ from another with respect to joint involvement by two processes: transfer of movement from one joint to another (what is called ‘movement migration’ in Poizner et al. 2000), and subtraction or addition of joints (Meier et al. 2008). As we noted above, movement of a distal joint generally takes less effort than movement of a more proximal one, so evidence that conversational variants favor DISTALIZATION (transferring movement to a more distal joint) over PROXIMALIZATION (transferring movement to a more proximal joint) would support the contention that there is a drive toward ease of articulation. Likewise, moving more joints generally takes more effort than moving fewer, especially if those joints are more distal. So FREEZING of joints (i.e. not moving joints that are active in the citation form) should be favored over GRAFTING joints (i.e. moving joints that are inactive in the citation form). Further, when freezing takes place, a drive for ease of articulation would predict that ESPALIATION (freezing of the most proximal joint in a multi-joint sign) should occur more frequently than PRUNING (freezing of the most distal joint in a multi-joint sign). (We coin espaliation on analogy to the botanical practice of training a plant to grow along a flat surface by tethering the proximal parts of its branches in order to fix the direction of their growth, leaving the distal parts of the branches free. The terms grafting and pruning extend the botanical analogy.) The study we carried out, which is reported on in §§3–4, confirms some of these predictions, and there have been other studies relevant to some of these predictions that also confirm them.

With respect to transfer of movement from one joint to another, this area of investigation has been undertaken by others, though with a more narrow focus. For example, Crasborn and van der Kooij (2003), henceforth C&vdK, consider variations in signs in Sign Language of the Netherlands (Nederlandse Gebarentaal, NGT) with respect to movement of the wrist joint and the base joint. C&vdK argue that the position of the base joint does not play a role in the phonological system of NGT. Rather, the position
of the base joint follows from other factors, just as the position of the wrist follows from other factors. In particular, they give evidence that there are no minimal pairs in NGT that differ only in bending of the base joint. Further, flexion is ‘not just two values “0” and “90”’ (C&vdK 2003:276), but rather a gradual variation. While others have noticed this fact in other sign languages (Greftegreff 1993 for Norwegian Sign Language; Mandel 1981 and Boyes-Braem 1981 for ASL), C&vdK handle it in depth, with an examination of the factors influencing base joint flexion.

The most interesting factor for our present purposes that C&vdK notice with regard to base joint flexion is that often flexion of the base joint as a whole (that is, all the first knuckles of the fingers) is an alternative to wrist flexion. They say movement has a tendency to move to the more distal joint (the base joint, as compared to the wrist joint) and that the real difference between flexion of the wrist and flexion of the base joint is ‘not the phonological specification of the movement, but rather the size of the phonetic realization of this movement’ (C&vdK 2003:269). Indeed, sometimes other factors, such as orientation, can influence the joint of articulation to the effect that the ‘most distal joint in the articulator that is not phonologically relevant’ (C&vdK 2003:274) will wind up being the joint of movement.

Their explanation for these observations about the locus of flexion is that distalization is articulatorily easy. Flexion at the base joint is ‘an efficient way of minimizing wrist flexion, and in some cases also shoulder and elbow movement, while still realizing the target output form for relative orientation and location’ (C&vdK 2003:276). Movement of an articulator with less mass (the fingers, rather than the entire hand) reduces the effort expended.

We have informally observed a trend toward effort reduction, especially distalization, in casual conversation, and the online ASL dictionaries reflect our observations. For instance, there are many examples where the more formal SS has a sign with movement of a proximal joint, whereas the more casual AP has the same sign with movement of a more distal joint: for example, SS has RELAX with shoulder movement, while AP has it with elbow movement; and SS has ATTENTION with elbow movement, while AP has it with radioulnar and/or wrist movement. The online ASL dictionaries also provide examples of freezing of joints (which no other studies we know of have addressed), both espaliation and pruning. For example, SS has HOW with shoulder, elbow, and radioulnar movement, while AP has an espaliated version with only radioulnar movement; SS has HOPE with shoulder and base movement, while AP has an espaliated version with only base movement; and SS has RUSH with elbow and wrist movement, while AP has a pruned version with only elbow movement.

Like C&vdK with respect to their data on the wrist joint and base joint, we find that the goal of maximal efficiency, regardless of the joint involved, is not an unmitigated concern. Production must constantly be mindful of the goal of comprehensibility. While distalization reduces the size of the sign and hence makes it more articulatorily efficient, the general shape of the sign in terms of its target path (what C&vdK refer to as ‘the target output form’) must be maintained in order to aid perception of the sign. Thus, in a sign like ALL-NIGHT-LONG, a circular path is created by movement of the shoulder, elbow, and radioulnar, as seen in the citation form given in Figure 8, and the overall visual shape of this path must still be evoked when movement distalizes (as in the variant in Figure 9), which we have frequently observed in casual conversation. The casual variant uses the radioulnar and wrist instead, while still making the hand trace a noticeable circle (though smaller, as the size of our arrow indicates) and thus allowing visual recognition of the sign despite the distalization.
Proximalization and ease of articulation. Though more distal articulations in sign languages generally require less effort, we do find that proximal articulations can be easier under certain circumstances. For example, as we noted in §2.1, the shoulder has the greatest range of movement, so its use can reduce the effort involved in making a precise movement. In this section, we discuss other examples of how a more proximal articulation can reduce effort, given that the notion of ease of articulation must encompass all types of effort, including matters of efficiency, precision, and motor control.

Proximalization to avoid awkwardness. Some citation versions of signs can be awkward to articulate. One citation form for HOUR (as in SS and AP) is highly iconic (Figure 10). The nondominant palm represents the clock face, while the dominant index finger represents the clock hand. The dominant index finger moves in a full circle, with the fingertip continuously pointing to the edge of the nondominant palm. In order to keep the hands close during movement, extreme radioulnar movement and extreme wrist flexion and extension, as well as a small shoulder movement, are required. Producing this citation form is awkward, and even uncomfortable for some.

Instead, fluent signers often use a less awkward form in which only the elbow and shoulder move (Figure 11); the dominant hand as a whole (rather than just the fingertip)
traces a circle on the nondominant palm (the orientation of the dominant hand also changes, facing toward the nondominant palm instead of outward). This form is often given as an alternative citation form (e.g. in SS, Handspeak, Lifeprint, ASL Browser, and Start ASL).

Thus, to avoid a physiologically awkward movement, an alternative articulation that moves a greater mass through more proximal articulation and that may even reduce iconicity may be used.

**First language acquisition.** Deaf children acquiring ASL tend to proximalize in their signs and gain distal movement as their signing matures (Meier et al. 1998, Meier et al. 2008). For example, adults articulate HORSE with base movement on the first and second fingers, but a signer who was eleven months and three weeks old signed it with wrist nodding instead, moving a larger mass (the entire hand), which should require more effort. Meier and colleagues attribute this tendency to issues of motor control.
phants generally gain motor control of proximal articulators before distal ones (cf. Gesell 1929, Gesell & Thompson 1934, Kuypers 1981, Meier 2000, and much work since). Meier and colleagues (2008) cite examples of how babies kick with more proximal activity than adults (Jensen et al. 1995) and how children first learning to write use large movements of the shoulder and elbow and only gradually learn to write with smaller movements of the wrist and fingers (Saida & Miyashita 1979).

McAllister (2009), building on work on the role of the jaw in babbling and early words (MacNeilage & Davis 1990), attributes certain tendencies of child phonology in spoken language to similar considerations. In many words in which adults move the tongue, children tend to move the jaw (with the tongue resting on it) instead of the tongue alone, which increases the overall mass moved. Movement of the mandible is motorically simpler than movement of the tongue, so the child effectively unites the tongue and the jaw, exploiting the more reliable motoric control of the jaw. Uniting the jaw and tongue also decreases the number of degrees of freedom in movement, that is, the dimensions of movement permitted by the articulators (Bernstein 1967). This is one more way that children reorganize their speech articulatory gestures as they acquire experience with language (see also Lowenstein & Nittrouer 2008).

Related to this account of children’s proximalization tendencies is a recent study on motor control in speech among prelingually deaf children who received a cochlear implant before the age of five. Horn and colleagues (2006) find that abilities in gross motor skills are correlated to age, whereas abilities in fine motor skills are correlated to expressive and receptive language scores. They suggest their findings indicate links between motor skills and spoken language development, but their findings could as easily indicate links between motor skills and language development regardless of modality.

In summary, children acquiring a sign language produce language that differs from adult language in systematic ways (Emmorey 2002, especially chapter 5), and proximalization is one of them because children’s gross motor skills are in place before their fine motor skills are (Rathus 2010), so they cannot yet access the more efficient articulations. Thus, they exhibit the drive for articulatory ease, with raw ability, rather than biomechanical effort, being the motivating factor.

Second language learning. Mirus and colleagues (2001) examine adult learners of a sign language. Hearing subjects, all Americans or Germans with little to no knowledge of a sign language, were asked to imitate videotaped signs taken from ASL and German Sign Language (Deutsche Gebärdensprache, DGS). Deaf subjects, native signers of ASL or DGS with little to no knowledge of the other sign language, were asked to imitate the same signs. Hearing subjects proximalized approximately 20% of the stimuli, but ASL signers proximalized only 3%, while DGS signers proximalized 8.75%. Prevalent errors across subjects were freezing of distal joints, proximalization of wrist movement to elbow or shoulder, or grafting of a proximal joint. Pichler (2010:116) also notes much proximalization among first-time adult signers of ASL.

Adults learning a new motor skill tend to reduce the number of active biomechanical degrees of freedom to be managed. Thus, they freeze some joints. Southard and Higgins (1987) report that people learning racquetball initially restrict wrist and elbow movement in favor of ‘whole arm’ movement, in which shoulder movement replaces more distal movement. Vereijken and colleagues (1992) report similar freezing of lower limb and trunk joints in adults learning to ski, noting that new skiers seem rigid and stiff, a result of using only proximal joints. Newell and McDonald (1994) report that adults who are asked to write with their nondominant hand use large movements of proximal joints, even after extensive practice. (Adult signers might similarly use more proximal
Theories of how one learns new motor skills agree that freezing of more distal joints is common in the first phase of learning (Schmidt & Lee 2005, Davids et al. 2008), although it is not universal (Broderick & Newell 1999). Mirus and colleagues (2001:105) suggest that desire to reduce the degrees of freedom explains the tendency for adult learners of a sign language to proximalize. As with children, the choice of which joints to use is based on what is easiest, that is, what is within the signer’s skill set. Cognitive and motor issues sometimes conspire to make movement of the proximal joints easier, despite the added mass.

**Non-effort-based factors in joint selection.** We have argued that to find evidence of a drive for articulatory ease in sign languages, it would be fruitful to look at differences in joint usage. There are, however, others factors that could affect joint usage that are not motivated by effort reduction, and thus are orthogonal to our discussion of articulatory ease.

Activity nouns can be formed from verbs by changing the manner of movement to a trill (Klima & Bellugi 1979), although this derivation is restricted to certain root verb stems (Brentari 1998:241ff.). Likewise, trilling can be used in other morphological processes, such as the derivation of approximative adjectives, as in YOUNGISH from YOUNG (Bellugi 1980, Padden & Perlmutter 1987). Trilled movements are small, quick, stiff oscillations (Liddell 1990). Although smallness can be achieved through proximal joint movement, often these trilled activity nouns involve a more distal joint for movement than the root verbs, such as in CHATTING (< CHAT) and RAPPING (< RAP), pictured in Figures 12 and 13, where the untrilled root verbs (Figs. 12a and 13a) involve radioulnar, elbow, and/or shoulder movement, but the trilled activity nouns (Figs. 12b and 13b) involve radioulnar and/or wrist movement (Padden & Perlmutter 1987), and a smaller movement repeated at least three times (indicated in our figures with smaller triple arrows). Though trills involve smaller movements, their quickness, stiffness, and higher number of repetitions may require more effort than the root verbs in some cases, despite the more distal articulation in the trilled sign.

![Figure 12. Derivation of activity noun from root verb CHAT.](http://www.aslpro.com/cgi-bin/aslpro/aslpro.cgi)

3 Video of Fig. 12a available from http://www.aslpro.com/cgi-bin/aslpro/aslpro.cgi.
Even though articulatory ease may play some role in the implementation of trilling, the fundamental motivation for trilling in the first place is not ease of articulation, but morphology. As noted above for spoken language, specifically for Irish consonant mutation (Kirchner 1998:108), the fact that the pattern is morphological places it outside the bounds of ease of articulation. Speakers (of Irish) and signers (of ASL) are not choosing to mutate consonants or trill their activity nouns because of a drive for ease of articulation, but because the morphological rules of their language require them to.

Like trilling, whispering in a sign language (i.e. signing so that others cannot see or are not disturbed) and signing in a limited signing space (e.g. video chatting on small devices like iPhones; see Keating et al. 2008 and Hibbard & Fels 2011) also require making signs smaller overall. Often shrinking the size of the sign involves distalization of the joint of movement (Brentari 1998, Keating et al. 2008). Again, ease of articulation may well play a role in how shrinking of a sign is specifically implemented (Crasborn 2001), but the fundamental reason for shrinking a sign in whispering or in a restricted signing space is not to reduce the effort of articulating the sign, but to satisfy the situational restrictions on intended audience or the size of the signing space. Consider the reverse scenario, when a signer is angry or excited, or is separated from the addressee by a considerable distance. In such a case, the signer will often shout by signing larger, which almost always involves the shoulder joint, so it often calls for proximalization (Brentari 1998, Crasborn 2001). But the reason for shouting is clearly not based on articulatory effort; there are external situational demands on how the sign needs to be produced.

Similar to what happens in shouting, parents will often add a proximal articulator when talking with their small children in situations where adults conversing among themselves would not (Holzrichter & Meier 2000). Holzrichter and Meier attribute this to the fact that proximalized signs are larger and hence more visually salient than citation forms (Brentari 1998). Again, this change in joint usage for child-directed signing is not based on a concern for articulatory effort, but on a completely different factor (here, a sociolinguistic register).

In all of these cases, the selection of joints changes and could be mistaken for evidence for or against a drive for articulatory ease in sign languages, but the actual fundamental drive behind each phenomenon is something unrelated (morphology, intended addressee, physical space limitations, register), and these cases therefore fall outside the domain of this work.
3. **Data collection procedures.** We now turn to our study of joint usage in casual signing by native ASL signers. The goal of this experiment was to elicit casual sign forms in ASL in order to look for evidence of pressure toward ease of articulation. An ideal study would examine casual ASL conversations. No appropriately annotated corpora of ASL conversations were available to us, however, so we instead asked linguistic consultants to sign lexical items the way they would in a conversation with a friend and compared their signs to those given in SS, our reference dictionary that presents a formal register for citation forms.

We generated a list of 500 randomly selected signs from SS. Duplicate articulations under different names were removed; for example, ASTONISH and SURPRISE are articulated the same way, so only one of them was included on the list, and the other was removed. Signs that involved no movement (such as the letter F and the number 5) were also removed. Each time we removed a sign from the list, we replaced it with another randomly selected one, and this process was repeated until the final list was composed of 500 signs involving movement, with no two signs having identical articulations.

We recruited two signers for two stages of this study. Both are native ASL signers in their thirties. One is female and grew up in the Philadelphia area, and the other is male and grew up in Austin, Texas, but for the past few years has lived in Washington, DC. We presented the first signer with the initial list of 500 signs, one at a time, in written English (as listed in SS), and asked her to sign each as she was videotaped. Many of the signs on the list turned out to be compounds. Many of these compounds were quite arbitrary (such as NIMBLE, which is signed in SS as EXPERIENCE + WALK-IN-HIGH-HEELS), which meant that our signer did not use the same component elements to express the same meaning. In addition, the fact that compounds are articulatorily complex would have made comparison of joint usage much more difficult and complicated. For both of these reasons, we excluded compounds from consideration for the rest of the experiment.

Our first signer produced some of the remaining signs with different joints from those used in the citation form in SS. We set these aside for further analysis, leaving us with a set of signs for which our first speaker either articulated the sign with the same joints as in the citation form, or did not produce a comparable sign for some reason: not recognizing the English word, using a very different version of the sign, or interpreting the English word with a different meaning from what was intended by the citation sign (MESH, for example, could be interpreted as a kind of cloth or as a way of fitting together). This sublist of signs was then signed by our second signer while he was videotaped. We then eliminated from further consideration all signs for which neither signer produced a version of the sign that was comparable to the citation form (such as MIDNIGHT, in which both of our signers incorporated the number 12, while the dictionary entry used a flat B handshape). This left us with a total of 222 signs for which we could compare at least one signer’s use of joints to that in the citation form.

Both signers are familiar with the notion of ‘conversational register’ in linguistic studies and have been linguistic consultants in a variety of linguistic projects, and our assessment of the videotapes confirmed that they were comfortable and adept at signing conversational forms before the camera, so we feel confident that their data were useful for our purposes. While both signers used a conversational register, our first signer also made many comments about the signs as she went along. In other words, she had multiple quick conversations with us in front of the camera. Since she did not know the goal of our research, her conversation was usually about lexical choices in different situations. Nevertheless, in these discussions she often produced multiple versions of a sin-
gle sign, giving us more variants to compare to the citation form than we had asked for or expected. The second signer began signing his list wearing a long-sleeved shirt, but then changed to a short-sleeved shirt partway through, and then went back and started over from the beginning of the list. So we had two versions of his signing for the first thirty signs; after that, he articulated each sign only once. The result of the combination of these two effects is that for some citation signs, we ended up with more variants than signers, and since our concern in this study is with what is possible in joint usage in casual signing, we included all variants.

Two of the authors worked independently to code the joint usage for all of the citation signs from SS and for all of the variants produced by our two consultants. All joint movement, no matter how minimal, was coded in a binary fashion for presence or absence of movement. But we add the caveat that radioulnar joint movement can often be slight (for discussion, see Mirus 2008). Likewise, shoulder movement ranged from little more than a hint to a robust lift or rotation. Where the authors’ codings disagreed, they consulted with each other to reach agreement. In many cases, it was necessary to slow the film and/or enlarge it in order to detect subtle movements.

For the purposes of coding joint usage with regard to internal hand movement, we adopt Corina’s (1990:32) distinction between secondary movement and change of handshape: ‘In secondary movement a single handshape alternates repeatedly between its specified shape and some restricted degree of closure’ such as bending or wiggling. Examples of secondary movement are seen in signs like COLOR, where the fingers of the 5 handshape wiggle. We also include in here flicks, as in ELEVEN or UNDERSTAND. And we note that, in contrast to Corina’s statement, repetition is not required in secondary movement, as in the wave movement in FASCINATE or POETRY. In contrast, examples of handshape change are seen in signs like LINGUISTICS, where the handshape changes from L to S. Displacement of movement from a more proximal joint to a hand-internal joint could result in secondary movement, but not in handshape change. For this reason we consider secondary movement but not handshape change in our discussion of joint usage.

Since we used a random sample of signs, our findings should be representative of how many and what kinds of changes in joint uses can occur in casual conversation across signs in general. However, our findings in no way bear on how prevalent any of these joint phenomena will be for any given signer or group of signers. For example, we have informally observed among signing friends that some signers distalize much more frequently than others do, and native signers can be surprised at what other signers produce. Nevertheless, our two signers produced the same overall pattern of articulation.

Of the 222 total citation signs used in our experiment, our signers produced comparable variants of 166 of them, where comparable variation means the same fundamental sign (handshape, movement, location), but with some difference in joint usage. From here forward, when we talk about ‘citation’ signs, we mean only these 166 signs; we do not analyze the remaining fifty-six signs that had no casual variants. We do not intend to suggest that these 166 citation signs are generally more prone to joint variation, but only that this behavior is found within the context of our specific experiment.

As stated above, sometimes our consultants produced more than one variant of a sign each, and sometimes they produced different variants from each other, which resulted in a total of 209 distinct variants of the 166 citation signs, which differ from the citation forms in multiple ways: freezing of one or more joints, grafting of one or more joints, and, often, a mix of these. We discuss the patterns among the 209 variants in §4. The raw data of joint usage for all 222 citation forms and casual variants are available online.

4. Joint usage in Evidence for ease of articulation. There are three major trends in our data concerning joint usage for casual variants of citation signs: (i) the average number of joints used decreases, so there is a strong preference for freezing joints (see §4.1); (ii) when freezing occurs, there is a mild preference for espaliation (freezing the most proximal joints) over pruning (freezing the most distal joints), and when grafting occurs, there is a strong preference for grafting more distal joints over proximal joints (§4.2); and (iii) for the two most proximal joints (shoulder and elbow), frequency of use decreases in casual variants more than for the four most distal joints (§4.3). The relevant groups of signs examined here are the 166 citation signs and their 209 casual variants. To determine statistical significance, we use $\alpha = 0.05$. When multiple comparisons are involved, we conservatively use the Bonferroni correction, with the adjusted significance level $\alpha'$ calculated by dividing $\alpha$ by the number of comparisons $n$.

4.1. Number of joints used. A basic measure of how joint usage differs between citation signs and casual variants is the raw number of joints used. The breakdown of the signs in both groups by number of joints is given in Table 1.

<table>
<thead>
<tr>
<th>Citation Signs</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>Casual variants</td>
<td>24</td>
<td>99</td>
<td>40</td>
<td>3</td>
<td>2.133</td>
</tr>
</tbody>
</table>

Table 1. Breakdown of the number of citation signs and their casual variants by number of joints used.

Comparing the mean number of joints used between citation signs and casual variants, there is a very significant decrease of about 0.7 ($p < 0.001$ for a two-tailed $t$-test). Change in joint usage can also be measured more directly with a repeated measures (matched pair) $t$-test, by categorizing each individual variant based on how many joints it lost or added with respect to its corresponding citation form (Table 2); for example, a casual variant of BOTTOM is articulated with the wrist only, but the citation form uses the elbow and wrist, so this variant has a joint change of $-1$.

<table>
<thead>
<tr>
<th>Casual variants</th>
<th>−3</th>
<th>−2</th>
<th>−1</th>
<th>0</th>
<th>+1</th>
<th>+2</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2</td>
<td>29</td>
<td>121</td>
<td>33</td>
<td>19</td>
<td>5</td>
<td>−0.746</td>
</tr>
</tbody>
</table>

Table 2. Breakdown of the casual variants by change in number of joints from citation form.

The mean joint change across variants is also a very significant decrease of about 0.7 joints ($p < 0.001$). These two ways of looking at the data yield slightly different results ($-0.683$ versus $-0.746$), because the repeated measures test counts a citation sign for each variant it has. Regardless of which test is used, the result is a very significant decrease of about 0.7 joints.

Since average joint usage decreases, freezing is preferred to grafting in casual variants, which we can measure by comparing the relative rates of freezing and grafting. The variants of one-joint citation signs always involve grafting (because freezing alone would result in no movement), so we compare rates of freezing and grafting only for the 182 variants of multi-joint citation signs (Table 3).

The file can also be downloaded from http://muse.jhu.edu/journals/language/v090/90.2.napoli01.html.
There is a very significant preference for freezing over grafting ($p < 0.001$ for a two-sample proportion test): 97% of the casual variants involve freezing of a citation joint, while only 29% involve grafting of a joint not found in the citation form. Note that forty-six variants (about 25%) involve both freezing and grafting, but this does not change the fact that freezing is strongly preferred over grafting. This is an expected result: using fewer joints requires moving less mass and, thus, expending less articulatory effort.

### 4.2. Proximity in freezing and grafting

We next examine the relative proximity of joints when joint change occurs, beginning with freezing. The breakdown of variants by joint proximity in freezing is given in Table 4. We consider only those variants for which freezing would be well defined in each proximity category. For example, for espaliation and pruning, we do not consider one-joint signs, because a single joint offers no distinction between being the most proximal and the most distal; we only look at the 182 variants whose citation forms have two or more joints, such as REMIND, which is articulated in citation form with the radioulnar and wrist, but which has an espaliated casual variant using only the wrist. Similarly, for medial freezing, because there are no distinct medial joints in one- or two-joint signs, we look only at the sixty-two variants whose citation forms have three or four joints, such as GOLF, which is articulated in citation form with the shoulder, elbow, and radioulnar, but which has a casual variant in which the elbow is frozen.

<table>
<thead>
<tr>
<th></th>
<th>YES</th>
<th>NO</th>
</tr>
</thead>
<tbody>
<tr>
<td>FREEZING</td>
<td>176</td>
<td>6</td>
</tr>
<tr>
<td>GRAFTING</td>
<td>52</td>
<td>130</td>
</tr>
</tbody>
</table>

**Table 3.** Breakdown of the casual variants of multi-joint citation signs by freezing and by grafting.

Of the casual variants whose citation forms could undergo espaliation, about 58% exhibit it. While this is greater than the rates for medial freezing (55%) and for pruning (51%), there are no statistically significant differences among these three rates ($p > 0.2$ for all two-sample proportion tests). Thus, we find no proximity effect in determining which joints will freeze. This is a somewhat surprising result, given that more proximal joints take more articulatory effort to move. This suggests that raw joint count is a more important factor than relative proximity of frozen joints.

We compare proximity in grafting in a similar way, and, again, comparison groups are determined by what kind of grafting is possible in the citation forms of the variants. For example, proximal grafting is possible when there are unused joints in citation form that are closer to the torso than the most proximal citation joint, as with COLOR, which uses only the base joint in citation form, but which grafts the shoulder in a casual variant. We analyze variants with one-joint citation forms separately from variants with multi-joint citation forms, because variants of one-joint signs always involve grafting and thus skew the results (e.g. of the sixteen total variants that involve proximal grafting, twelve of them have one-joint citation forms). The breakdown of variants of one-joint signs by joint proximity is given in Table 5.
Proximal grafting occurs in 86% of casual variants of one-joint signs in which proximal grafting is possible, which is greater than the rate of 56% for distal grafting. However, this difference is not statistically significant \( (p = 0.11) \). Thus, we find no proximity effect in determining which joints will be grafted in one-joint citation signs.

The method of comparison is similar for proximity of grafting in multi-joint citation signs. The breakdown of these variants is given in Table 6.

Of the casual variants whose citation forms could undergo distal grafting, about 17% exhibit it, which is significantly smaller than the 35% rate for medial grafting \( (p = 0.014, \) with a Bonferroni corrected significance level of \( \alpha' = 0.017 \) for three comparisons). Proximal grafting occurs at a rate of 33%, but there is no statistically significant difference between this and the rate for medial grafting \( (p = 1.0) \) or distal grafting \( (p = 0.32) \), likely because of the low occurrence of proximal grafting in the data. Thus, proximity has an effect, with medial grafting preferred over distal grafting; we cannot draw any strong conclusions about the relative frequency of proximal grafting. Given that joint proximity is not a factor in joint choice for freezing or for grafting in one-joint citation signs, the fact that grafting in multi-joint signs is somewhat sensitive to joint proximity needs an explanation. In order to address this issue, we need to look at how usage of the individual joints differs.

### 4.3. Individual Joint Usage

We consider joint usage for each joint individually, rather than over all signs and all joints (as in §4.1) or based on comparative proximity within a sign (as in §4.2). Here, we look at each joint in each casual variant and tabulate whether that joint is grafted, frozen, or remains the same with respect to the citation form. For each joint, we define its mean change in usage (MCU) as the number of variants in which that joint is grafted minus the number of variants in which that joint is frozen, divided by 209 (the total number of casual variants). These relevant data are given in Table 7, and the MCU is graphed in Figure 14.

<table>
<thead>
<tr>
<th>SHOULDER</th>
<th>ELBOW</th>
<th>RADIOLUNAR</th>
<th>WRIST</th>
<th>BASE</th>
<th>INTERPHALANGEAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO CHANGE</td>
<td>89</td>
<td>109</td>
<td>160</td>
<td>166</td>
<td>198</td>
</tr>
<tr>
<td>GRAFTING</td>
<td>15</td>
<td>22</td>
<td>20</td>
<td>28</td>
<td>1</td>
</tr>
<tr>
<td>FREEZING</td>
<td>105</td>
<td>78</td>
<td>29</td>
<td>15</td>
<td>10</td>
</tr>
<tr>
<td>TOTAL CHANGE</td>
<td>−90</td>
<td>−56</td>
<td>−9</td>
<td>+13</td>
<td>−9</td>
</tr>
<tr>
<td>MCU</td>
<td>−0.431</td>
<td>−0.268</td>
<td>−0.043</td>
<td>+0.062</td>
<td>−0.043</td>
</tr>
</tbody>
</table>

Table 7. Breakdown of the casual variants by type of change for each joint.

There is a statistically significant difference for about half of the comparisons of MCU between any two joints; the \( p \)-values for the comparisons are given in Table 8 (statistically insignificant \( p \)-values are given in parentheses, with a Bonferroni corrected significance level of \( 0.0033 \) for fifteen comparisons).
The two most proximal joints (shoulder and elbow) each have a significantly lower MCU than each of the four most distal joints (radioulnar, wrist, base, and interphalangeal), showing a greater decrease in average usage from citation form to casual variants.

Although the remaining differences in MCU are not statistically significant, some are close, and there is a pattern (observable in Fig. 14) that might turn out to be significant in a more robust, specialized study with a less conservative significance level. For the four most proximal joints, shoulder usage has the largest decrease (−0.43), elbow usage has the second largest decrease (−0.27), radioulnar usage slightly decreases (−0.04), and wrist usage slightly increases (+0.06). For the two most distal joints, we see the potential source of the discrepancy between medial and distal joints noted in §4.2: the two hand joints actually decrease in usage, rather than increase, as would be predicted solely by concerns for articulatory ease. We provide an explanation for this issue in §4.4.

4.4. Overall findings. There are three major trends in our study regarding the differences in usage of joints between citation forms and their casual variants. First, there is a strong tendency toward freezing, with casual variants having about 0.7 fewer joints than their citation form. The reason for this decrease in number of joints used is clear: 97% of the variants involve freezing, while only 29% of them involve grafting. So,
when the casual articulation of a sign differs from its citation form, there is a strong preference for reducing the number of joints.

Second, when freezing and/or grafting do occur, there is generally no effect from relative proximity of a joint with respect to the citation joints. When freezing occurs, there is no statistical preference for espaliation, medial freezing, or pruning. The very fact that the number of joints decreases is enough to alleviate articulatory effort; whether the frozen joints are proximal or distal within the sign is not important. When grafting occurs, there is also no statistical preference between proximal grafting and either medial or distal grafting. However, medial grafting is somewhat more preferred over distal grafting (35% to 17%). This is an unexpected result if our only consideration is reduction of articulatory effort.

Our third and final major result leads us to an answer for this apparent problem. While relative joint proximity within a sign is not usually a significant factor, absolute proximity is, at least when comparing the two proximal joints to the four distal joints. The shoulder and elbow are significantly reduced in usage from citation form to casual variants in comparison to the radioulnar, wrist, base, and interphalangeal. This pattern fits our model of articulatory ease: the more proximal a joint is, the more effort is needed to move it (cf. Fig. 6), and therefore the less likely it is to be used in contexts where articulatory ease is prized, such as casual conversation. All other factors being equal, the base and interphalangeal joints, being the most distal, should have the greatest positive change in MCU in comparison to the other joints, but all other factors are not equal. The base and interphalangeal joints are hand-internal, which means they serve a dual purpose in sign languages: they are used not only for movement, but also for handshape, which the other four joints do not contribute to. There are two ways in which the hand joints’ role in handshape would inhibit changes in their usage.

First, since handshape is an important piece of a sign’s visual identity, separate from movement, adding or removing movement at the base or phalangeal joints would tend to obfuscate the original handshape and thus interfere with recognition of the sign, which would be an impediment to effective communication. Second, as Mirus and colleagues (2001) point out, specific handshapes may simply block adding any movement to the base or interphalangeal joints. For example, a sign like YES is normally signed by moving the wrist (Figure 15a), and it is anatomically possible for it to be proximalized to the shoulder (Figure 15b). The sign cannot undergo grafting of the base or interphalangeal joints, however, because the handshape requires all of the fingers to be closed, so the hand joints are unavailable to make the characteristic nodding movement of the sign (Figure 15c).

In contrast, Mirus and colleagues point out that the wrist in a sign like WARN (Figure 16a) can be frozen, and its movement proximalized by grafting the shoulder (Figure 16b) or distalized by grafting the base joint (Figure 16c).

Overall, our experiment clearly demonstrates patterns compatible with our notion of effort reduction, and thus with our argument that there is a drive for ease of articulation in sign languages. This drive is realized as a general preference for freezing of joints and for greater use of distal joints over proximal joints, with the wrist possibly being the most preferred distal joint, because the base and the interphalangeal joints have other constraints on them independent of articulatory ease, due to their role in handshape.

5. Conclusion. Our two main observations about fluent casual signing are that (i) there is a strong tendency to freeze joints found in citation form and (ii) that there is a general correlation between joint proximity and change in usage from citation to casual
form (modulo potential interference with handshape). These observations support our prediction that sign languages may exhibit tendencies toward effort reduction based on mass being moved. In addition, we have noted that fluent adult signing and various types of disfluent signing may have a preference for proximal joints under certain circumstances (avoiding awkward articulations, children acquiring a sign language natively, and adults learning a second sign language), which point to other kinds of effort reduction beyond mere reduction of mass being moved: effort reduction based on awkwardness, raw physical ability, or complexity in learning.

Our results mesh well with previous crosslinguistic work on other ways to reduce effort (particularly on undershooting of handshape and location), leading to one conclu-

---

5 Video of Fig. 15a available from http://www.aslpro.com/cgi-bin/aslpro/aslpro.cgi.
6 Video of Fig. 16a available from http://www.aslpro.com/cgi-bin/aslpro/aslpro.cgi; a variation similar to that of Fig. 16b (with both shoulder movement and a slight wrist move) can be seen at http://www.signingsavvy.com/sign/WARN/6064/1.
sion: sign languages have a drive toward ease of articulation. Since spoken language also has such a drive (§2.2), we conclude that the drive toward ease of articulation is a characteristic of language in general, though the mechanical details are obviously different between the two modalities: speakers and signers find ways to reduce the effort required to use their language, but the specific biological factors are not the same.

Furthermore, the fact that other physical activities, such as sports (§2.3), exhibit a drive toward ease of articulation suggests that the linguistic drive for ease of articulation is an instantiation of a larger drive toward ease of articulation in all activities that use the body. Indeed, this motoric tendency is likely realized not just in human bodies, but in other animal bodies as well. Nevertheless, this drive may be stronger in language articulation than in others. Brentari and Poizner (1994) report a tendency toward distalization in a deaf Parkinsonian signer, and Poizner and colleagues (2000) point to undershooting, distalization, and movement segment reduction as ways of reducing effort among Parkinsonian signers. These effects are limited to signing and not found in non-linguistic movement. Given that language is the primary voluntary motor activity used on a daily basis to connect humans to each other, it would not be surprising for a general motoric drive toward ease of articulation to be particularly strong in language. Regardless of its ultimate source, this drive for articulatory ease plays an important role in the shape of both spoken languages and sign languages.

REFERENCES


Dolata, Jill K.; Barbara L. Davis; and Peter F. MacNeilage. 2008. Characteristics of the rhythmic organization of vocal babbling: Implications for an amodal linguistic rhythm. *Infant Behavior and Development* 31.422–31


Lindblom, Björn; Susan Gu ion; Susan Hur a; Seung-Jae Moon; and Raquel Willer man. 1995. Is sound change adaptive? *Rivista di Linguistica* 7.5–37.


Petitto, Laura Ann; Siobhan Holowka; Lauren E. Sergio; Bronna Levy; and David J. Ostry. 2004. Baby hands that move to the rhythm of language: Hearing babies acquiring sign languages babble silently on the hands. *Cognition* 93.43–73.


On the linguistic effects of articulatory ease, with a focus on sign languages

500 College Avenue
Department of Linguistics
Swarthmore College
Swarthmore, PA 19081
[donnajonapoli@gmail.com]
[nsander1@swarthmore.edu]
[becky.c.wright@gmail.com]
Dear Author/Editor
During the preparation of your manuscript for publication, the questions listed below have arisen. Please attend to these matters and return this form with your proof. Many thanks for your assistance.

[AQ1] Since these two figures were so small I placed them side-by-side. This also allows me to fit Figure 5 at callout instead of on the next page. Hope this is okay.